
 

State of Florida 

Department of Transportation 

 

 

 

 

 

FDOT AutoCAD Civil 3D Essentials 

 

User Training Guide 

 

PRODUCTION SUPPORT CADD OFFICE 

TALLAHASSEE, FLORIDA 
http://www.fdot.gov/cadd/ 

  



 

 



Page 1 of 46 

 

 

 

 

 

FDOT AutoCAD Essentials 
 

 

Table of Contents 

PREREQUISITES ..............................................................................................................................................3 

CONTACTS .....................................................................................................................................................3 

REQUEST CADD SUPPORT ............................................................................................................................................3 

FDOT CADD SUPPORT COMMUNITY .............................................................................. ERROR! BOOKMARK NOT DEFINED. 

CADD SUPPORT EMAIL ................................................................................................................................................3 

1 MICROSTATION JARGON VS AUTOCAD JARGON .......................................................................................5 

FUNCTIONS IN AUTOCAD, BUT NOT MICROSTATION.........................................................................................................5 

2 EXPLORING THE AUTOCAD/FDOT CIVIL 3D STATE KIT INTERFACE ..............................................................6 

RIBBON TABS ..............................................................................................................................................................7 

THE COMMAND LINE ....................................................................................................................................................8 

APPLICATION MENU .....................................................................................................................................................8 

QUICK ACCESS TOOL BAR ..............................................................................................................................................8 

INFO CENTER ..............................................................................................................................................................8 

DRAWING AREA (MODEL SPACE) ...................................................................................................................................9 

TOOL PALETTES ...........................................................................................................................................................9 

MODEL AND LAYOUT TABS ............................................................................................................................................9 

STATUS BAR ................................................................................................................................................................9 

3 PANNING AND ZOOMING ...................................................................................................................... 10 

MOUSE ................................................................................................................................................................... 10 

ZOOM KEYBOARD COMMANDS ................................................................................................................................... 10 

TOUCH PAD ............................................................................................................................................................. 10 

4 AUTOCAD SELECTION TOOLS .................................................................................................................. 11 

GRIPS ..................................................................................................................................................................... 11 

WINDOW SELECTION ................................................................................................................................................. 12 

SELECTION TOOLS KEYBOARD COMMANDS ................................................................................................................... 13 

SELECTING AND THEN RIGHT-CLICKING ......................................................................................................................... 14 

CONTEXT SENSITIVE RIBBON ....................................................................................................................................... 15 

DISPLAY ORDER ........................................................................................................................................................ 15 

5 PROPERTIES ........................................................................................................................................... 16 

6 CREATING OBJECTS ................................................................................................................................ 18 

LINE........................................................................................................................................................................ 18 

ARCS ...................................................................................................................................................................... 18 

CIRCLES ................................................................................................................................................................... 19 

RECTANGLES ............................................................................................................................................................ 19 

ELLIPSE ................................................................................................................................................................... 19 



Page 2 of 46 

 

 

 

 

POLYLINES ............................................................................................................................................................... 20 

3D POLYLINES .......................................................................................................................................................... 21 

OTHER GENERAL TIDBITS ABOUT LINES: ........................................................................................................................ 22 

FLATTEN ............................................................................................................................................................... 22 

7 THE STATUS BAR.................................................................................................................................... 23 

USING OBJECT SNAPS ................................................................................................................................................ 23 

AUTOCAD MAP 3D MAP COORDINATE SYSTEM ............................................................................................................. 25 

SWITCH BETWEEN MODEL SPACE AND PAPER SPACE ...................................................................................................... 25 

ORTHO MODE .......................................................................................................................................................... 25 

POLAR TRACKING ...................................................................................................................................................... 25 

OBJECT SNAP TRACKING ............................................................................................................................................ 26 

SELECTION CYCLING .................................................................................................................................................. 26 

ANNOTATION OBJECTS .............................................................................................................................................. 26 

8 MODIFY TOOLS ...................................................................................................................................... 27 

ERASE ..................................................................................................................................................................... 27 

MOVE ..................................................................................................................................................................... 27 

USE A STRETCH-MOVE .............................................................................................................................................. 28 

COPY ...................................................................................................................................................................... 28 

OFFSET ................................................................................................................................................................... 28 

ROTATE ................................................................................................................................................................... 29 

EXPLODE ................................................................................................................................................................. 29 

9 WORKING WITH LAYERS ........................................................................................................................ 30 

LAYER PROPERTIES (MANAGER) .................................................................................................................................. 31 

USING LAYER STATES ................................................................................................................................................. 32 

FDOT LAYER NAMING CONVENTION: .......................................................................................................................... 32 

OTHER LAYER TIDBITS: ............................................................................................................................................... 33 

10 BLOCK BASICS .................................................................................................................................... 34 

INSERTING FROM A TOOLPALETTE ................................................................................................................................ 35 

INSERTING A BLOCK USING THE INSERT COMMAND ........................................................................................................ 37 

Existing Block .................................................................................................................................................... 37 

Browsing for Blocks ........................................................................................................................................... 38 

Insert Block Settings ......................................................................................................................................... 38 

11 PAPERSPACE AND MODELSPACE ......................................................................................................... 39 

THE MODEL (SPACE) TAB ........................................................................................................................................... 39 

LAYOUT - PAPERSPACE ............................................................................................................................................... 40 

LAYOUT- MODELSPACE .............................................................................................................................................. 41 

12 PRINTING AND PLOTTING ESSENTIALS ................................................................................................ 42 

GETTING READY TO PRINT .......................................................................................................................................... 42 

13 EXTERNAL REFERENCES (XREFS) .......................................................................................................... 44 

14 NEXT STEPS ........................................................................................................................................ 46 

 

  



Page 3 of 46 

 

 

 

 

Prerequisites 

Before you can start using Civil 3D, you’ll need to become familiar with the basic operation of AutoCAD. 

This course introduces you to basic operations and how these operations translate over to the functions 

and use of Civil 3D.  

A few assumptions are made before we begin: 

• You are getting ready to learn Civil 3D 

• You have a mouse with a scroll wheel. 

• You have a decent knowledge of Windows operating system. 

• You know how to browse for files using windows explorer. 

• You know what a save icon looks like.   

• You know what an undo icon looks like.   

• You have used Microsoft Word or a similar word processing program. 

• You are teaching yourself AutoCAD from within the FDOT Civil 3D interface. 

• You may have a MicroStation, or perhaps a previous version of AutoCAD background. 

• You have the FDOT Civil 3D State kit installed on your office workstation or PC (Personal 

Computer). 

Note PDH Credit will only be available with Instructor lead or Computer Based Training (CBT) thru Learning 

Curve. 

Contacts 

REQUEST CADD SUPPORT  

https://fdotservicedesk.dot.state.fl.us/  

User Support portal to directly input an issue ticket into the Department’s service desk.  This requires a 

one-time request to create a user login account.  Your ticket will be routed to the next available CADD 

Support staff who will contact you for assistance.  Once entered the user may login at any time to check the 

status of their open issues.   

Note The CADD Service Desk can be accessed from inside MicroStation from the FDOT Menu under the 

Standards option. 

CADD SUPPORT EMAIL 

cadd.support@dot.state.fl.us   

https://fdotservicedesk.dot.state.fl.us/
file:///E:/ECSO_Docs/Training%20Manuals/FDOT2017C3D%20Manuals/FDOT%20AutoCAD%20Essentials/cadd.support@dot.state.fl.us
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Support emails received at this address are routed to the whole CADD Support staff to address by the first 

available. This email should always be included with any direct email request, comment or suggestion in 

the case the individual CADD Support staff is out of the office or unavailable. 
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1 MicroStation Jargon vs AutoCAD Jargon 

The following table list terms that are used between the MicroStation and AutoCAD CAD platforms. 

 

MicroStation AutoCAD 

Smartline Polyline 

Line Line 

Level Layer 

Cell Block 

Element Object 

Dimension Dimension 

Block Rectangle polyline 

Handle Grip 

Drop element Explode 

Update View Regen 

Element Priority Draw order 

Pen Tables Plot Styles 

View Modelspace Viewport 

Configuration file Options 

Element attributes Properties 

Fit View Zoom Extents 

Patterning Hatching 

AccuDraw Polar tracking 

Seed file Template drawing file .(dwt) 

Tags Attributes 

 

FUNCTIONS IN AUTOCAD, BUT NOT MICROSTATION 

• A Save button. AutoCAD behaves more like other Windows programs with it’s save functionality. 

• Paperspace and Modelspace. MicroStation uses the concept of “sheet models” to do what 

AutoCAD does in layout mode. 

• Undo for multiple actions. 

• AutoCAD is Command line driven, most menus and buttons send commands to AutoCAD via 

command line. 
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2 Exploring the AutoCAD/FDOT Civil 3D 

State Kit Interface 

The FDOT Civil 3D State Kit is divided into 9 parts.  

The tools that you will use in the course of reading this document are: 

• Ribbon 

• Command line 

• Application Menu 

• Quick Access toolbar 

• Info Center 

• Drawing area (Model Space) 

• Tool Palettes 

• Model and Layout Tabs 

• Status Bar 
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RIBBON TABS 

 

The tabs across the top, (Home, Insert, Annotate, Modify, Analyze, View, Manage, Output, Survey, 

Autodesk 360, Help, Featured Apps, Express Tools, and FDOT) represent different categories of tools. Each 

tab gives you a logical grouping of tools. 

When a tab is active, you will see the tools split into more specific categories in panels. Panels bring specific 

types of commands together.  For example, let’s look at the Draw Panel.  

 

At the top of the panel are the more common tools. This panel can be expanded by clicking the black 

dropdown arrow.  We see quite a few more tools. 

 

Click the thumb tack icon on the lower loft of the panel to keep the expanded view. 

Click the thumb tack again to roll the panel back to its original position. 
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THE COMMAND LINE 

The AutoCAD command line is how you and AutoCAD communicate with each other.  

 

Execute a command by entering a full or portion of a command alias at the prompt and press ENTER or 

SPACEBAR. When Dynamic Input is on and set to display prompts, you can also enter commands in 

tooltips that are displayed near the cursor 

AutoCAD will tell you what type of information it is expecting, and you tell AutoCAD the value or option 

you want. 

When you see Command: in the command line, you know that AutoCAD is not busy, and waiting for you 

to give it your next instructions. 

Every tool that you use has a key-in version as well as an icon on the ribbon. For instance, you can click the 

polyline icon or type PL at the command line, then hit enter. 

APPLICATION MENU 

Click the Application button to create, save, audit, recover, or publish a file. Search for commands that are 
available on the Quick Access toolbar, in the Application menu, or on the ribbon. You can also view, sort 
and access support files you opened recently. 

QUICK ACCESS TOOL BAR 

Add Command and Controls. Add as many tools as you need to the Quick Access toolbar. Tolls that extend 
past the maximum length of the toolbar are displayed in a fly out button. To add a command, right-click 
the button a select Add to Quick Access toolbar. 

INFO CENTER 

Search for information through key words or phrases, displayed the Communication Center panel for 

product updates and announcements, or display the Favorite’s panel to access saved topics. 
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DRAWING AREA (MODEL SPACE) 

By default, you start working in a limitless 3D/2D drawing area called model space. You begin by deciding 
whether one unit represents one Millimeter, one centimeter, one inch, one foot or whatever unit is most 
convenient. You then draw at a 1:1 scale. 

TOOL PALETTES 

Access standard and custom components symbols (blocks) subassemblies, and various commands. All 
Palettes can be launched from the Home ribbon on the Palettes panel. 

 

MODEL AND LAYOUT TABS 

After drawing in model space, you switch over to a Layout tab to prepare your drawing for printing. Here 
you can set up different layout with title blocks and notes; and on each layout, you create layout 
viewports that display different views of the model space. In the layout viewports, you scale the model 

space views relative to paler space. One unit in paper space represent the actual distance on a sheet of 
paper, either in  millimeter or inches, depending in how you configure your page setup. 

STATUS BAR 

View the coordinate values of the cursor and access buttons for turning on or off drawing options (such as 
tracking, snapping, panning, zooming, dynamic input, and so on). You can also switch between various 
workspaces. 
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3 Panning and Zooming 

MOUSE 

You can pan to reposition a view and zoom to change the magnification of a view. Typically, most of your 
panning and zooming will be done with your mouse’s wheel or similar device. 

• Roll the wheel forward to zoom in to an object. 

• Roll the wheel towards you to zoom out. 

• For zooming with the wheel, the location of your 

cursor is where AutoCAD centers the screen. 

• Press and hold the middle mouse wheel to pan the 

screen.   

• Double-click the middle mouse wheel to zoom extents. 

ZOOM KEYBOARD COMMANDS 

Typing Z or Zoom at the command line provides the following options: 

• All - Zooms to display all visible objects and visual aids. 

• Center - Zooms to display a view defined by a center point and a magnification value or a height. A 

smaller value for the height increases the magnification. A larger value decreases the 

magnification. 

• Dynamic - Pans and zooms using a rectangular view box. The view box represents your view, which 

you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans 

or zooms to fill the viewport with the view inside the view box. 

• Extents - Zooms to display the maximum extents of all objects. 

• Previous - Zooms to display the previous view. You can restore up to 10 previous views. 

• Scale/Scale factor - Zooms to change the magnification of a view using a scale factor. 

• Window - Zooms to display an area specified by a rectangle window. 

• Object - Zooms to display one or more selected objects as large as possible and in the center of the 

view. You can select objects before or after you start the ZOOOM command. 

TOUCH PAD 

If you use a touch pad, you can use gestures to pan and zoom. 

• Zoom in - Slide thumb and index finger apart. 

• Zoom out - Pinch thumb and index finger together. 
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4 AutoCAD Selection Tools 

Knowing how to select objects efficiently in AutoCAD will make using Civil 3D much easier. The first 

thing you need to know is that if you are not actively in a command, AutoCAD is in a selection mode. 

After you are done with a command, the tool you are using is no longer active and you are back at a 

Command: prompt in the AutoCAD command line.  

 

This is very different for users who may be used to software that keeps you in a command until you 

switch tools (such as MicroStation or Photoshop). 

All of the techniques discussed in this section will work outside of a command or at the Select 

Objects: prompt when you start working with commands. 

GRIPS 

When you are not in a command, and you click on an object, you will see blue squares at key points. 

These blue squares are called grips. 

• If you click a grip, you can move or adjust the object. 

• Hover over a grip for modifying options.  

If you are in a command, such as move, you will not see grips but you will see objects become dashed. 
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WINDOW SELECTION 

WINDOW.  Type W this option is implied when the select objects prompt displays. Using a window selects 

all objects completely inside a rectangle defined by two points. To create a window, select its corners from 

left to right. 

To select multiple items at once, use a selection window. Click on the screen where you have no CAD 

objects and a selection window is started. Drag across your screen and you will see a temporary 

rectangle forming. 

Note The direction that you drag your selection window makes a difference. 

o Clicking left to right across your screen will give you a blue field with a solid line around it. 

o Only objects that are completely inside the blue area will become selected. 

o Items that are partially in, but cross the solid line are not selected. 

 

CROSSING. Type C to create a window that selects objects that are either completely inside or partially 

inside the window. The crossing window displays as a dashed line or is highlighted Dragging right to left 

across your screen will give you a green field with a dashed line around it. 

o Clicking right to left across your screen will give you a green field with a dashed line. 

o Objects inside the green area and anything touching the dashed line will become selected. 

o Items that are partially inside will also become selected. 
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LASSO.   Lasso allows you to select objects and components by drawing a free form shape around them.  To 

engage the Lasso tool, click and hold down the left mouse when drawing your selection window.    Let go to 

stop the Lasso and confirm your selection.  Drawing the lasso to the left acts as a crossing selection, while 

drawing to the right will be a window selection.  While drawing your lasso you can also press the Space Bar 

to cycle between crossing and window. 

 

 

SELECTION TOOLS KEYBOARD COMMANDS 

Typing the following commands provides the following selection options: 

WINDOW - Type W this option is implied when the select objects prompt displays. Using a window selects 

all objects completely inside a rectangle defined by two points. To create a window, select its corners from 

left to right. (If you create a rectangle from right to left, you create a Crossing window.)  

CROSSING - Type C to create a window that selects objects that are either completely inside or partially 

inside the window. The crossing window displays as a dashed line or is highlighted (in comparison, the 

window selection rectangle is a solid line). To create a crossing window, select its corners from right to left.  

BOX - Type BOX to select objects that are completely inside or partially inside the box. This selection 

method is the same as the Crossing window if the box is select from right to left. If it is selected from left to 

right it is the same as Window.  

LAST - Type L to select the most recently created visible object.  

ALL - Type ALL to select all objects on layers that are thawed or turned off. This option does not affect 

objects on frozen layers. (Be careful using this one!!)  

Fence - Type F to select all objects that cross a selection fence. The Fence method is similar to CPolygon 

except that AutoCAD does not close the fence, and a fence can cross itself.  

Crossing polygon - Type CP to create a CPolygon (crossing polygon) to select objects that are within or 

crossing a polygon defined by the points you specified. The polygon can be any shape but cannot cross or 

touch itself. (AutoCAD draws the last segment of the polygon so that it is closed at all times.)  
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Window Polygon - Type WP to create a WPolygon to select objects completely inside a polygon defined by 

points. The polygon can be any shape but cannot cross or touch itself. (AutoCAD draws the last segment of 

the polygon so that it is closed at all times.)  

Group - Type G to select all objects within a specified group. An option - Type A to add objects or switches 

to the Add method. Selected objects can be added to the selection set by using any of the object selection 

methods. Auto and Add are the default methods.  

Remove - Type R to remove objects or switches from the Remove method. You can remove objects from 

the current selection set using any object selection method. To remove specific objects, press the SHIFT key 

while selecting objects.  

 

Multiple - Type M to select multiple objects by selecting points without highlighting the selected objects. 

This option is useful when selecting complex objects because it helps with performance. The Multiple 

method also selects two intersecting objects if the intersection point is specified twice. 

Previous - Type P to select previously selected objects. To clear the previous selection, use any operation 

that deletes the objects that were selected.  

Undo - Type U to undo or cancel the last selected object that was added to the selection set.  

Automatic - Type AU to switch to automatic selection by pointing to an object to select the object. Pointing 

to a blank area inside or outside an object creates the first corner of a box defined by the Box method. 

Auto and Add are the default methods.  

SI - Type SI select the first object or set of objects instead of being prompted for additional objects to 

select.  

SELECTING AND THEN RIGHT-CLICKING 

When in doubt? Right-click! It is important to get comfortable with using the right-click button on 

your mouse. In Civil 3D and AutoCAD, right-clicking after selecting objects presents you with all sorts 

of options.  Select Similar is a very power selection tool to use. This allows you to quickly select 

objects with shared properties. 
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CONTEXT SENSITIVE RIBBON 

Selecting a Civil 3D oject like a Surface, Pipe, Structure, Alignment, Corridor…. Will change the Ribbon on 

top. The Ribbon is context sensitive, and responds to the type of intellegent object that is being selected. 

The example below shows an Alignment being selected and the ribbon displaying all the options that 

pertain to Alignments. 

 

DISPLAY ORDER 

If you draw something in AutoCAD, and then draw another thing on top of the first thing, the second 

thing will obscure the first thing where they overlap. 

Select the object you wish to work with.  Right-click and select display order. 

o Bring to Front. Takes the selected object and puts it in front of other objects that intersect it. 

o Send to Back. Pushes the selected object behind all the others that it intersects. 

o Bring Above Object. Moves the selected entity on top an object you select. 

o Send under Object. Moves the selected entity behind the object you select. 

 

Note Display order has no effect on actual elevation.  It’s just a graphics thing. 
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5 Properties 

The properties palette allows you to see information about a selected object and make modifications.  

From the previous section you should know that selecting an object, and right-clicking it is a way to view 

commands associated with an object. Properties is one of the items you can access this way. 

 

You can also access the properties palette by clicking the Properties icon from the palettes panel on the 

Home tab. 
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You can change many things about an object right from here, such as the layer and elevation. 

 

At the top of the properties palette, you will see the type of object you have selected. 

If you have multiple objects selected, you will see the number of items in parentheses at the top of the 

properties pane. 
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6 Creating Objects 

All of the draw commands are located on the Home tab > Draw panel. 

 

The differences between lines, polylines and 3D polylines are significant to the Civil 3D world. 

LINE 

An AutoCAD line is any two points in space. You create a series of contiguous line segments. Each 

segment is a line object that can edited separately.   

 

• A line can have differing elevations at each end. 

• The differing elevations may be a result of snapping to nodes of different elevation. 

• Be aware that a chain of single lines will not join if they have a Delta Z value other than 0. 

• Also, if you convert a line to a polyline, check the resulting polyline elevation. The result may be 

totally unexpected! 

ARCS 

To create an arc, you can specify combinations of center, endpoint, start point, radius, angle, chord 

length, and directions values. Arcs are drawn in a counterclockwise direction by default. Hold down 

the Ctrl key as you drag to draw in a clockwise direction. 
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CIRCLES 

Creates a circle based on a center point and a radius or diameter value. 

There are many methods to creating a circle. You can create one based on a Radius, Diameter, 3P 

(Three Points), Tan, Tan, Tan, 2P (Two Points), TTR (Tangent, Tangent, Radius) values. 

 

RECTANGLES 

Creates a rectangular polyline from the specified parameters (Length, width, rotation) and type of 

corners (fillet, chamfer, or square). 

 

ELLIPSE 

Creates an ellipse or an elliptical arc. The first two points of the ellipse determine the location and 

length of the first axis. The third point determines the distance between the center of the ellipse 

and the end point of the second axis. 
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POLYLINES 

The term Polyline refers to a 2D polyline. A 2d polyline is a chain of line segments and/or arcs at the same 

elevation. 

 

 

 

A polyline can be at an elevation, but every vertex is at the same elevation. 

When you start the polyline command, if you happen to snap to something at an elevation, the rest of your 

line will all be at the same elevation. 
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3D POLYLINES 

A 3D polyline is also a chain of line segments, but it cannot contain arcs. Each vertex of a 3D 

polyline can be at different elevations. 

 

 

You can edit each vertex independently through the properties if you wish. 

Notice how the screen shot at left shows that we are sitting on vertex 7. 

You’ll also see the 7th vertex from the left has an X glyph on it, showing us graphically what we are editing. 

When you get into Feature Lines in Civil 3D, there are much slicker ways to set elevations. 

Civil 3D Function Line Polyline 3D Polyline 

Convert to Alignment Yes (Civil 3D 2010 +) Yes No 

Convert to Feature Line Yes Yes Yes 

Convert to Pipe Network Yes Yes, but…* Yes 

Add to Surface as Breakline Yes Yes, but…* Yes 

Add to Surface as Contour No Yes Yes 

Convert to Profile Yes No No 

Note Watch your elevations!  Remember all vertex elevations are the same for a polyline. 
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OTHER GENERAL TIDBITS ABOUT LINES: 

Splines are evil.  Do not use these! You may receive a drawing from someone who thought splines 

looked pretty when they drew contours in base AutoCAD. In this situation use SPLINEDIT command to 

convert splines to polylines. 

If you have individual line segments and wish to convert them to a polyline use the PEDIT command . 

• Start the PEDIT command. 

• Type M for Multiple. 

• When you are prompted to convert objects to polylines, hit enter for yes. 

• Type J for join.   (Then enter) 

• If all of the segments are touching, you can use a fuzz distance of 0. If there are gaps between the 

lines, type a fuzz distance that will force the lines to close.  (Hit enter) 

• The command line will report how many segments were joined. If fewer segments were joined 

than you expected – there are two possible causes: 

✓ The lines are at differing elevations. (Use the FLATTEN command to fix) 

✓ The fuzz distance is not large enough to close the gaps. 

If you have objects that you wish to “smoosh” down to zero elevation, use the FLATTEN command.  

  

FLATTEN  

Creates a 2D representation of selected objects and projects them onto the current viewing plane. 

FLATTEN results in 2D objects that retain their original layers, line style, colors and object types where 

possible. You can use FLATTEN to create 2D drawing from a 3D model, or you can use it to force the 

thickness and elevations of selected objects to 0.  
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7 The Status Bar 

Located at the bottom of the user interface (UI) is the Status Bar.  This bar displays status information 

about the current drawing and provide access to commands that can be applied to the drawing. We 

will cover the commands that are most commonly used in this chapter. 

Hover your cursor over the icons to display a tool tip presenting you with the name of the command. 

Some of the commands may not be displayed or seem missing. To turn on additional commands, select 

the customization icon on the far right to make a selection. 

Right-clicking on each icon will usually display a short cut menu with addition setting and options 

specific to that command. 

 

USING OBJECT SNAPS 

Object Snaps enable you to quickly select exact geometric points on existing entities without having to 

know the exact coordinates of those points. 

Use object snaps to draw more precisely. You can make sure that object truly “touch” or are drawn the 

way you intended. 

 

The most common object snaps you’ll use are endpoint, midpoint, node and intersection. 

If you right-click on the OSNAP icon at the bottom of your screen you’ll see a list of the available snaps 

that you can have running all the time when you are drafting.   Active snaps are highlighted in blue. 
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The most useful snaps to know for the Civil 3D user are: 

 

 Endpoint - Endpoint grabs the ends or vertices of any type of line or arc. 

 Midpoint - Midpoint grabs the “halfway point” between two vertices of any 

line or arc. 

 Node - Node snaps to points. In the case of a Civil 3D survey point, node 

coincides with the insertion point. 

 

 

Intersection - For two objects at the same elevation, intersection picks the 

point where they cross. (If the objects are at different elevations, use 

Apparent Intersection) 

Other useful tidbits about Object Snaps: 

• If you want your object snaps to ignore the elevation of the object you are picking, type 

• OSNAPZ at the command line.  Set this variable to 1. 

• Be patient when using object snaps on Civil 3D objects. Sometimes it takes a moment for the object 

snaps to sort out all the data you have on your screen. Pause your cursor where you expect the 

object snap to appear and it will pop up. 

• Be aware of your zoom level when running object snaps. OSNAPS work even when the object you 

are snapping to is off-screen. For example, the closest endpoint of a line may be outside of your 

screen’s view. When you click, the line you are drawing will jump to that off-screen spot. 

• You can turn object snaps on/off on the fly by using the F3 key. 

• Use the Shift Right-Click to issue a temporary object snap. This will allow you to select any of the 

same Object Snap commands from a short cut menu 
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AUTOCAD MAP 3D MAP COORDINATE SYSTEM 

You can assign a coordinate system to your drawing file from within the library, and you can edit and 

delete any user defined items in the library. Use the Coordinate System Library to view coordinate 

systems, datum’s, ellipsoids, geodetic transformation and geodetic transformation paths 

 

At the command line you can type SETFLEAST, SETFLNORTH, SETFLEASTNP, SETFLNORTHNP, 

SETFLWEST and SETFLWESTNP to quickly assign Florida specific coordinate systems to your file. This 

option is only available with the FDOT Civil 3D State kit installed. 

 

SWITCH BETWEEN MODEL SPACE AND PAPER SPACE 

Quick switch between model space and paper switch in the current layout tab. Double click in the view port 

will have the same effect.  If no view port is present then the command will remain in paper space mode 

 

ORTHO MODE 

Constrains cursor movement to the horizontal or vertical directions. 

• Short Key  F8 

• Command  ORTHOMODE 

 

POLAR TRACKING 

Tracks the cursor along specified polar angles. 

• Short Key  10 

• Command  POLAR 
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OBJECT SNAP TRACKING 

Tracks the cursor along vertical and horizontal alignment paths from object snap points 

• Short Key  11 

• Command  OTRACK 

 

 

SELECTION CYCLING 

Controls the display behavior when you hover over or select an object that overlaps other objects. 

• Short Key  Ctl+W 

• Command  SC 

 

ANNOTATION OBJECTS 

These commands control the scale factor display of Annotation objects.  Annotation object include 

dimension, notes, and other types of explanatory symbols or objects commonly used to add information to 

your drawing. 
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8 Modify Tools 

Once you locate these commands on the Modify Panel, the only learning curve working with the tools is 

getting used to the order in which you do your clicking and picking. These commands work in a similar 

fashion.  All start with selecting the objects you wish to modify. Then require a base point, second point to 

rotate, move, mirror… then the displacement point usually finishes the command sequence. 

 

The main thing to keep in mind is to watch the command line to help steer you in the right direction. 

ERASE 

There are two main ways to erase objects in AutoCAD. 

• The easiest way is to select the objects you wish to remove and then press the delete key. 

• If you want AutoCAD to prompt you to select objects, use the erase command E from the modify 

toolbar. Use one of the various selection methods to erase objects 

MOVE 

Moves objects a specified distance in a specified direction. Use coordinates, grid snaps, object snaps, direct 

distance entry and other tools to move objects with precision. 
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USE A STRETCH-MOVE 

You can also use a STRETCH to move objects if all their endpoints lie entirely within the selection window. 

Turn on Ortho mode or polar tracking to move the objects at a specific angle. A practical example is moving 

a door in a wall. The door in the illustration is entirely with in a crossing selection, while the wall lines are 

only partly with in the crossing area. 

 

COPY 

Copies objects a specified distance in a specified direction. 

 

OFFSET 

Creates concentric circles, parallel lines, and parallel curves. 

The offset command adjusts the geometry of the line to get a consistent distance between the original 

and offset line. This means that arcs will have different radii in the offset object. 

You can offset almost every object except 3D polylines using base AutoCAD 
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ROTATE 

Rotates objects around a base point 

By default, AutoCAD considers due East = 0°. 

When we get into Civil 3D there are more options for specifying angles (such as bearing), so if the angle 

defaults in AutoCAD bug you, don’t worry! 

 

EXPLODE 

There are some situations where you want to break apart an AutoCAD object into components that make 
it up. For example, you may wish to turn a polyline into several line segments. You may wish to turn a 

block into regular lines. To break down an object into smaller parts Explode can be used.    

  Use Explode with caution! Using explode on a Civil 3D object (Such as a surface) will remove the 

information behind it, leaving you with just the graphical representation.  

                              

Before Explode     After Explode 
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9 Working with Layers 

Use layers to control the visibility of objects and to assign properties such as color and line type. Objects 

on a layer normally assume the properties of that layer. However, you can override any layer property of 

an object. For example, if an object’s color property is set to BYLAYER, the object displays the color of that 

layer. If the object’s color is set to Red, the object displays as red, regardless of the color assigned to that 

layer. 

Layers are the primary method for organizing the objects in a drawing by function or propose.  Layers can 

reduce the visual complexity of a drawing and improve display performance by hiding information that 

you don’t need to see at the moment. 

• When you are using the FDOT Civil 3D state kit, layers are already defined for you in any drawing 

you create. After you create a new drawing set the layer that you wish to use as current.  

• Everything you draw should go on a layer. No exceptions! The good news is that once you get Civil 

3D involved, it will “push” things to the correct layer. 

• Layers are key to AutoCAD in keeping your drawing well organized. 

• They are especially valuable when it comes to printing because you can freeze items you don’t wish 

to display on a plot. 

When you start a drawing tool and start drawing, that line is being created on the current layer. You can 

tell what layer is current by looking at the layer dropdown on the Home tab > layer panel. 

 

To switch which layer is current, make sure nothing is selected in the drawing and click on the 

dropdown arrow and select the layer you want. 
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LAYER PROPERTIES (MANAGER) 

Note Modelspace and viewport concepts are discussed in depth in the next section. 

 

Icon What it does: Additional Info: 

 

 

Layer is thawed in main modelspace Use the Thaw All Layers tool if you want to see 

things on layers that had previously been frozen  

 

 

 

Layer is frozen in main modelspace 
and all viewports 

This is the best option to use is you wish to 
manipulate visibility of layers 

 

 

Layer is on in main modelspace Use the Thaw All Layers tool if you want to see 

things on layers that had previously been off   

 

 

Layer is off in main modelspace 
and all viewports 

Similar to frozen but AutoCAD still considers the layer 
with zoom extents and REGEN commands 

 Layer is locked. Objects on that layer may be seen, but can’t be 
manipulated 

 

 

Layer is unlocked and available for 
editing. 

Most of your layers will be unlocked while drafting is 

taking place 

 Layer is thawed in current viewport Every viewport can be different.  Use this to your 
advantage 

 

 

Layer is frozen in current viewport Using the Layer Freeze command inside a viewport will 

only affect the viewport you are working in – VERY 

HANDY!  

 

 

Layer will not plot This is a drawing-wide setting for a layer. Frequently 
used for Viewport layers 
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USING LAYER STATES 

When you work with the FDOT Civil 3D State Kit, you’ll see that every element goes to its own layer. This 

means that a FDOT Civil 3D project can easily have several hundred layers. To help manage the layers (and 

your sanity) use Layer States. 

You can switch between predefined Layer States based on disciplines. 

 

You can easily get back to that layer “situation” by hitting the dropdown again and setting your 

desired state current. 

This also works inside viewports! So if you’ve got a layer state you’d like to plot, double click inside the 

viewport and set the layer state you want current. More information on viewports at the end of this 

book. 

FDOT LAYER NAMING CONVENTION: 

FDOT has created six Standard Layer libraries:  Common, Survey, Right of Way, Roadway, Photogrammetry 

and Structures. There are approximately 1500 Layers. The appropriate Layers and Layer Filters load upon 

the creation or opening of a FDOT Design file using the Create File application. The Layer name is a 

maximum of 18 characters and has three components:  Layer Name, State and View with the format: 

object_sv  

Where:   (object = Layer) (s = State) (v = View) 

(S)tate Designations (V)iew Designations 

p (proposed) p (plan) 

d (drafting entity) r (profile) 

e (existing) x (cross section) 

 m (model) 

An example of a plan view Layer is: PavtMessage_ep, where: Layer = PavtMessage, State = e  and View = p 
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Note Some Layers do not show a State or View in their name. These Layers are by default set to 

be a proposed plan view entity. An example is the Layer (RPM1), created for proposed 

RPM’s in the plan view. 

The Layers symbology (color, weight and Line Type) are set to ByLayer, Which means each Layer has a 

color, weight and style associated to it and controls all objects placed on that particular layer. It is 

recommended that Designers not create additional Layers since they will not QC. 

 

OTHER LAYER TIDBITS: 

When an object is selected, its layer is displayed in the layer dropdown. 

To change and object’s layer: 

1. Select the object whose layer you wish to change 

2. Go to the layer dropdown on the Home tab > layers panel 

3. Pick the new layer. 

A really great command to know is the Layer Previous command . If you want to get back to the layer 

state you were in last, hit this and it will take you back.  

For example, say you accidentally hit Thaw All Layers in a viewport.  Layer Previous will restore the 

layers. 

Layer 0 cannot be deleted or renamed. Because layer 0 is in every drawing finished projects should have 

nothing on layer zero. Layer 0 is generally used to create blocks on. This also makes working with external 

references difficult to manage. 

Do not use the Defpoints layer. It doesn’t plot, and is used by AutoCAD as a placeholder for dimension. 
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10 Block Basics 

A block is a group of AutoCAD objects that have been tied together. A block can be used like a rubber 

stamp - you can have the same items over and over in the same drawing without having to recreate them. 

Every block has a main base point. The base point appears as a grip when you select the block. 

 

For using Civil 3D, being able to create a block isn’t as necessary as knowing how to utilize ones that have 

already been created. 

Here are the most common ways to work with existing blocks: 

• Insert a block from a tool palette 

• Insert a block that already exists in the drawing 

• Insert a block that comes from an external DWG. 
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INSERTING FROM A TOOL PALETTE 

Remember most Palettes are access from the Home Ribbon on the Palettes panel to open up the 

toolpalette, click the icon. 

When you are using the FDOT Civil 3D, the first set of tools you will see on the tool palette are special 

roadway creation tools known as Assemblies and Subassemblies. To access some of the blocks available to 

you, right-click on the edge of the tool palette. 

The list of names that contain FDOT are custom pallets. Select the FDOT Structures pallet group name. 

Once you have switched palettes groups, the set of tabs along the side of the palette will change. 

The tabs represents different groupings of tools. 

 

This tool palette contains blocks that are useful to FDOT specific standards. 
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1. Click on any block icon in the list. 

 

2. The first click places the base point of the block wherever you click in the graphic. 

3. The second click establishes the rotation of the block. 

4. After you are done setting the rotation, you are back at a Command prompt. 
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INSERTING A BLOCK USING THE INSERT COMMAND 

If you don’t have blocks set up on a tool palette, you can use the more traditional Insert Block command.  

From the Insert tab, go to the block panel and select Insert. 

 

At this point you will need to decide where the block information is coming from. 

• Existing in the current drawing 

• External file – Select More Options… 

EXISTING BLOCK 

If a block has already been inserted into the drawing or is defined in the template, you can easily insert it 

using the insert block command. 

1. Go to the Insert command. 

2. Click the dropdown to see the blocks available to you. 

3. Select the block you wish to work with. 

4. Set your Insertion point, scale and rotation options. 

5. Click OK. 
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BROWSING FOR BLOCKS 

A block is just a special case of a DWG file.  In fact, any DWG file can be used as a block. 

1. When you get to the insert dialog box, click the Browse button and navigate to the folder 

where the DWG is saved 

2. Set the insertion, scale and rotation options. Click OK. 

3. Once the block has been pulled in from an outside file, it is no longer necessary to browse out 

for it again. It will now show up in the list of blocks available in the drawing 

 

INSERT BLOCK SETTINGS 

You will notice many checkboxes on the insert block settings dialog box. 

o The insertion point refers to where the block base point is going to end up when you place it in 

your drawing. 

o The scale refers to how large the block will come in; as compared to the size the block was defined.  

You always want Uniform Scale checked on. 

 

Rotation specifies the angle at which the block will come in. This rotation angle is similar to the rotation 

angle used in the rotate command. 

o The block unit is AutoCAD reporting to you if it is doing any unit conversion. 

o For instance, if the block you have browsed for has been created in inches, AutoCAD will show the 

conversion that is automatically happening. 

 

Explode should remain unchecked.  You can always explode the block after it has already been inserted. 

Generally you will have these boxes unchecked when placing your blocks. 
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11 Paperspace and Modelspace 

Working with Paperspace and Modelspace can be a funky concept for people who have never used 

AutoCAD before. 

 

The tabs on the bottom of the drawing area will switch you between main Modelspace and the layout tabs. 

THE MODEL (SPACE) TAB  

You will work in real-life scale; a 24’ wide road will be 24’ wide. Always draw your objects at a 1:1 scale in 

Modelspace. 

The model tab is where you will do the vast majority of drafting, design and annotation. 

  

The annotation scale you see while you are working in Modelspace affects the size of text placed by Civil 3D 

or annotative text placed by AutoCAD.  While you are in the model tab, this scale is determined by drafter’s 

preference. Because you will do all your plotting out of paperspace, the scale doesn’t affect anything at all 

– other than your ability to see it! 
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LAYOUT - PAPERSPACE 

The layout tabs are there for you as you get ready to print your project. Switch to the layout tab you wish 

to work with by clicking on the name of the tab at the bottom of your drawing screen. Once you have 

switched to the layout, you will see the following: 

 

The above screen capture shows a layout tab with a title block inserted. 

• The layout tabs represent how your page will be arranged when printed*. 

• The big white square represents the size and orientation of the piece of paper you would like to 

print* 

• The dashed line represents the printable bounds, or the limit as far as how close to the edge of the 

paper you printer can print. The distance between this dashed line and the edge of paper is usually 

determined by the printer you are sending your design to. 

• The viewport is a window into your design. 

• The triangular Paperspace UCS icon is a sign to us that we are in paperspace. Any drawing we do 

when the triangular icon is showing will only be on our current layout. We are not affecting 

Modelspace as long as you see this symbol on the PAPER button at the bottom on the screen 

• Any zooming in and out just zooms the paper itself, and does not affect the final print of the 

drawing. 

• Paperspace is where you will draw your title block, add north arrows and add text related to the 

date, project location etc.  
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LAYOUT- MODELSPACE 

If you double-click inside the viewport you are activating a viewport. 

You’ll notice that the UCS icon changes and the viewport outline gets heavier. You are now in 

Modelspace. 

We can now work inside the viewport. Any drawing we do at this point affects the main model. 

 

Note If we zoom and pan in this state you are changing the scale and location of the Modelspace view. 

  



Page 42 of 46 

 

 

 

 

12 Printing and Plotting Essentials 

Printing out of AutoCAD is very closely related to the layout tabs. 

All formal printing will happen from the layout tabs. The only time you would print from the Model tab is if 

you are just creating a check – and are not concerned about scale or a title block. 

By the way, “printing” and “plotting” are interchangeable terms – so don’t get confused if AutoCAD or I 

switch it up on you. 

GETTING READY TO PRINT 

In the section about layouts, I told you what you were looking at when it comes to the paper and the 

printable bounds, but I never told you how to get the paper size you want. 

  

Right-click on the tab you are working with. Select Page Setup Manager… 

 



Page 43 of 46 

 

 

 

 

 

• By default the printer will be set to the correct device. All printers that you are attached to will 

show up in this list, as well as some options for printing to a file (such as PDF). 

• Next, set your paper size. The list of sizes comes from the printer. The “what to plot” option should 

always read “Layout”. 

• Leave the plot offset at X: 0.000 .inch, y: 0.000 .inch. 

• Plot scale should be 1”=1’. Remember we set the viewport to an appropriate scale, so the scaling is 

taken care of already. 

• The color table needs to be set to reflect how you want to handle colors from the drawing. 

• The color table will be set for you automatically. FDOT.stb is the default FDOT table. 

• Want full-color, what-you-see-is-what-you-get in your print?  Use FDOT-Color.stb 
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13  External References (XREFs) 

External references are a way of viewing another drawing as a backdrop for your current drawing. You can 

measure, snap to and work with layers of the items in the referenced drawing. 

• There are several reasons why you would want to use XREFs: 

• Prevents your current drawing from getting too big. 

• Allows other people to work in the XREF’d drawing while you are working in the current drawing. 

• Gives you access to some Civil 3D data in the XREF’d drawing. 

First, create a new layer for your XREF, for instance, “XREF1”.  (Color doesn’t matter) 

 

Set the new layer current. 

 

Before you attach a drawing as an XREF, save your current drawing.   

To attach another drawing, go to the Insert tab > Reference panel and click Attach. 

Make sure your Files of Type is set to DWG. It is possible to attach other types of files, but we’re sticking to 

the basics in this document. 

 

Use the Overlay option. 
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Set the Path type to Relative path. Click OK. 

If your current drawing and the XREF drawing are in the same coordinate system, keep the scale, insertion 

point and rotation at the default values. 

If they are not, toggle on the Locate using Geographic Data option. 

The XREF layers now appear in the Layer Properties manager and can be frozen & thawed individually just 

like any other layer. 

 

If you want to hide the entire XREF quickly, you can Freeze the “XREF1” layer. 
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14 Next Steps 

This document covers the bare-bones basics if you are new to the current release of AutoCAD. 

Topics you may also want to understand, but are not critical to working with Civil 3D include: 

• Working with text 

• Working with dimensions 

• Understanding annotation scale 


